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INTRODUCTION  

We all have clients who are using QuickBooks but many of them are not using it correctly. 

QuickBooks is very easy to use—once it has been set up properly and the clients are trained on 

the proper method to enter transactions. However, many of these clients have learned to use the 

software by trial and error. Clients think that since a check looks like a check and an invoice looks 

like an invoice; they too can be a bookkeeper. Without training in accounting and time spent 

analyzing many of the different reports, quite often they believe everything is fine.  

By going through the following issues, and the related ―fixes‖ you will be better equipped to 

quickly and easily identify the most common QuickBooks errors clients make and understand the 

alternatives to effectively and efficiently correct the situation at hand.  

Although it is never fun to tell a client they have been entering information incorrectly, this reality 

does provide you a great opportunity to develop a closer relationship with the client as their 

QuickBooks expert and to train them how to use the software to provide better business 

information for compliance and decision making purposes. 

NOTE: Keep in mind that this course includes the most common mistakes clients make, but it is by 

no means all encompassing of all the mistakes you will encounter when working with clients. 

OBJECTIVES 

 Understand data file types and other initial considerations  

 Explore symptoms and causes of common mistakes 

 Determine if these mistakes occurred and the impact on the accounting records 

 Discover alternatives available to fix these mistakes 

 Identify ways to minimize these mistakes in the future.  

NOTES ABOUT APPROACH 
Because various users choose to use the navigators on the home page, or not, and may 

customize the icon bar, these instructions will use the menu bar at the top of the software. 

QuickBooks
®
 PREMIER: Accountant Edition 2010 is the version of the software that is used in 

this course. While many of the fixes will work with other versions, this is the most comprehensive 

and feature rich product that includes reports and functionality accountants want and need. We 

are using the sample data file (Rock Castle Construction) included with the software to make it 

easy for you to test the solutions with your own copy of the software back in your office. 

 

Also, the majority of these fixes require that you have access to the live data file. Some solutions 

cannot be implemented when using the Accountant‘s Review Copy of the data. There are many 

ways to access the live data including working at the client‘s office, obtaining a back up or 

portable file of the data to use in your office (don‘t forget to remind the client not to enter any 

transactions while you have it or your back up or portable file will overwrite their information), 

utilize the Accountant‘s Copy or use QuickBooks Premier: Accountant Edition 2010 feature of 

Remote Access or another service that allows remote access to the client‘s computer. 
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IMPORTANT  NOTE 

One thing you can never do enough is back up the data. Do not overwrite the previous backups. 

Back up before you start and at every major step along the way. In most cases you will not need 

to restore the back up, but if you do, being able to restore the data to a specific point in time is 

critical. Backing up to the client‘s hard drive is OK (but make sure you know where you have 

saved the files), but it is recommended that you burn a CD or copy the backup files to a USB 

drive so you can take them with you. What has worked well for me is to back it up using today‘s 

date then add a letter to subsequent backups, as the naming convention for the back-up file.  

 

NOTE: Have you asked your client what frequency and method they are using for backing up their 

QuickBooks data? Make this part of your training or year-end planning session. Also make sure they 

periodically test their backups to ensure they restore correctly. If the client has their network or 

computer backed up automatically, I still suggest they backup to a CD or USB drive periodically. It is 

also critical that they have a backup offsite.  

Within QuickBooks there is no undo, undelete, or any other way to say ―Oops, I didn‘t mean to do 

that.‖ For this reason, in addition to the back ups, it is recommended that you print any 

information you may need. This may be a report, it may be the journal entry associated with a 

transaction, etc. When you print the report, don‘t forget to print the report to one page wide 

(landscape may increase the font size slightly) and to widen any columns that contain critical data 

that may be cut off by moving the diamond to the right at the top of the column.  

NOTE: You do not have to print to paper, you can print to PDF and save it electronically. You can get 

CutePDF free (www.cutepdf.com) and select it as you would any printer. 

http://www.cutepdf.com/
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For major changes, those that will take considerable time, and the situations where information 

has been entered incorrectly, having the client sit with you while the changes are made serves 

three purposes: 

 They see the results of the situation they have created which will hopefully help them to 

do better in the future. 

 They understand the changes that have been made in the file which will often eliminate 

the subsequent calls about what you did or why things look different than before. 

 They know firsthand the amount of time it took for you to correct the problem which will 

hopefully remove the ―surprise factor‖ when they receive your request for payment. 
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ACCESSING YOUR CLIENT‘S DATA FILE AS EXTERNAL ACCOUNTANT USER 

If you are going to be making changes to your client‘s data, it is recommended that you document 

these changes. If you use the Accountant‘s Copy feature in QuickBooks Premier: Accountant 

2010, your changes will be tracked and documented for you and your client to print. Your client 

will have the opportunity to accept them when you give them the accountant‘s copy back to 

merge with their existing data file. 

NOTE: Make sure to communicate to the client that they should NOT cancel the Accountant‘s 

changes or restore the data file. Even if they create another Accountant‘s Copy, your changes will not 

import since they no longer have exactly the same data file that created the original Accountant‘s 

Copy. 

New in 2009, there is another way to track the changes you make to your client‘s data file is to 

have the Administrator of your client‘s file create an External Accountant role for you in their data 

file.  You will make these changes in the External Accountant role in the client‘s live QuickBooks 

data file. The External Accountant user allows the Accountant access to all areas of QuickBooks 

similar to the Administrator role. In the past, in order to get Administrator level access, the 

Accountant would have to sign in as the Administrator on the file. The downfall of signing in as 

the Administrator is that any changes that the Accountant makes are combined with the client‘s 

changes in the QuickBooks file. Now with the External Accountant user, the Accountant has 

access to all sensitive accounting activities and information in the QuickBooks data file without 

needing to be logged in as the Administrator. 

NOTE: The only limitations for the External Accountant user role are that you are unable to add, edit 

or delete existing users of the QuickBooks file and you cannot view customer credit card information. 

The Administrator of the QuickBooks data file is the only person that can create an External 

Accountant User in the QuickBooks file. Once created, the Accountant should always log on with 

their own login to perform their accounting tasks in the QuickBooks file. This enables any 

changes made by the accountant in the QuickBooks file to be tracked separately. The External 

Accountant should be the only one allowed to have this user role in QuickBooks since it has 

Administrator-level access to the QuickBooks file.  Instruct your client to not use the External 

Accountant login or give the login information to anyone else in the office. 

NOTE: You are able to log in as the External Accountant in QuickBooks Pro and Premier Editions 

and QuickBooks Enterprise Solutions, as long as the Administrator creates this user role for you in 

their company file.  
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To setup an External Accountant User (by the Administrator): 

1. On the Company Menu, select Set Up Users and Passwords.  

2. Select Set Up Users.  

3. Click Add User…. 

 

4. Enter User Name and Password for the Accountant. 
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5. Select the External Accountant access for the Accountant. 

 

6. Select Yes to give the Accountant access to all areas of QuickBooks. 

 

7. Review the Access rights and select Finish to finalize the set-up for the External 

Accountant. 
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CLIENT DATA REVIEW (CDR) 

Client Data Review (CDR) was introduced in 2009 with 4 new tools in 2010.  This feature is 

included in QuickBooks Premier: Accountant and QuickBooks Enterprise Accountant Edition.  

Client Data Review can be accessed in QuickBooks Pro 2009 or 2010 when you log in as the 

External Accountant User, but you will only have access to the CDR features and tools for 2009 

(i.e. you will not have access to the new tools for 2010). Client Data Review helps to find and 

clean-up data entry errors made by your clients in QuickBooks without having to search for them 

manually.  

Client Data Review helps accounting professionals be more productive when detecting and 

correcting client data errors. When asked in a ProAdvisor newsletter survey (April 2008), 

accounting professionals indicated that as much as 60% of their billable time is spent 

troubleshooting and correcting client data files, yet it remains one of the least profitable activities 

the professionals provide for their clients. 

The Client Data Review feature includes the following: 

 A single working screen that provides access to tools and reports only available in CDR 

 Links to critical QuickBooks menus and reports 

 Real –time data refresh as corrections are made to the client‘s data 

 ―Freezes‖ your prior period reviewed balances. The next time you review the client‘s file 

your stored balances are compared to current QuickBooks balances for that review 

period. If CDR finds a difference, a recommended journal entry to restore your original 

balances is prepared for your review. (You remain in control however, because you 

choose if that suggested journal entry gets posted or not.) 

 A tool to quickly reclassify transactions 

 Tracks changes to the QuickBooks lists including added, deleted, merged or edited 

 Provides a working screen to conveniently apply open customer or vendor payments or 

credits to associated open invoices or vendor bills. (Note that you cannot apply credits if 

you are working with an Accountant‘s Copy file transfer) 

 Write off invoices feature 

 Troubleshoot inventory feature 

 Tracks the status of individual review ‗steps‘ as well as documenting overall review notes 

 Marks a review as ‗completed‘ allowing you to either re-open the review or begin a new 

period review 

 Prints details for the review 

 Available for use in QuickBooks Accountant‘s Copy data sharing file type (limited to 

features available in Accountant‘s Copy) 

Throughout this course, Client Data Review tools are discussed where applicable. 
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LIST ERRORS 

ERRORS & SYMPTOMS 

Common Errors: 

 Duplicates 

 Accounts duplicate the function of customers, vendors, or items 

 Numerous old accounts, customers, vendors or items 

 Numerous miscellaneous, one time vendors, customers or items 

 Items setup and used incorrectly 

Symptoms:  

 Long lists  

 Balance Sheet and Profit & Loss reports look wrong (i.e., accounts set up with an 

incorrect type, too many cost of goods sold accounts, etc.) 

One of the easiest places for most accountants to start is to deal with chart of accounts issues. 

Based on experience and training, it is usually apparent fairly quickly if the chart of accounts is 

too long, if there are duplicates, or if the accounts have been set up as the incorrect type. The 

account type controls the presentation for financial reports and it is used for the highest level of 

subtotals.  

Looking over the chart of accounts list or creating the Balance Sheet and Profit & Loss reports will 

provide an indication of the extent of the issue. 
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REVIEW LIST CHANGES 

Within the Client Data Review feature is a tool to help you review and analyze list changes made 

by the client. Here you can review the different lists in QuickBooks for changes that your client 

may have made since your initial set-up of the file or your last round of clean-up in the data file. It 

will identify Added, Changed, Deleted or Merged List Items or Accounts since the last review. The 

following lists can be viewed for these changes through Client Data Review:  

 Chart of Accounts  

 Item List 

 Payroll Item List  

 Fixed Asset Item List  

 

This enables you to expedite finding the changes that your clients have made to these lists and 

identify list elements that you can change in the QuickBooks file based on your analysis. It tracks 

the changes that you make as well. You are able to QuickZoom into any list item or account 

shown to take you to the Edit window for the account or item. From there, you can make any 

necessary changes if applicable. 

Also listed in this section are the Customer List and Vendor List. These two lists are not 

supported by Client Data Review as far as changes being tracked. However, by selecting these 

lists through Client Data Review, you are directed to the Customer or Vendor Center, depending 

on which list you choose. This serves as reminder to go to each of these lists to review for 

duplicates, ones that should be merged, inactivated or deleted during your clean-up engagement. 

(Remember that merging cannot be un-done, so proceed carefully when merging list items.) 
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CORRECTING ACCOUNT TYPES 

In the previous screen capture, under accounts that were added, Loan from Bank of America is 

shown as an Income type account. To fix this, you will need to go into the data file and edit the 

account to the appropriate account type. Using the CDR means that you no longer have to exit 

back to the lists or chart of accounts menu, you can double-click on the item itself and it will open 

the edit box. 

From within CDR, under the added area where you see the Loan from Bank of America, double 

click. This brings up the edit box. From the Account Type drop down menu, change the account 

type to the correct one, in the example below we are changing it from Income to Long Term 

Liability. 
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MERGING OR INACTIVATING DUPLICATE CHART OF ACCOUNTS  
OR LIST ITEMS 
Often clients will inadvertently create duplicate accounts or list items. This is especially common 

when there are multiple users of a QuickBooks data file. Additionally, clients may create more list 

items than are necessary. For example, a client may add a vendor for every gas station whereas 

they could use a generic vendor called ‗gas station‘. You can clean up the lists by making things 

inactive or merging them as explained below. 

Duplications can be made inactive by following these steps: 

1. Click Lists, Chart of Accounts. 

2. Right click the account to be edited and select Edit Account. 

3. Place a checkmark in the Account is inactive box, see the following screen capture. 

 

Inactive accounts will not appear in list selections but will appear in financials for those periods 

where there is activity. For this reason, ―deactivating‖ paid-off loans and fully-amortized asset 

accounts is the preferred method rather than merging or deleting. Additionally, if you are 

inactivating a Balance Sheet account that should not show a balance, then clear the activity in the 

account before inactivating it. 

Duplicate accounts can also be merged. As shown in the Client Data Review tool, it identifies the 

accounts (and other list items) and the destination account for the merger.  

However, it should be noted that once you merge an account, it is not reversible. All prior 

transactions appear as if they had always been posted to the original account. So it is wise to 

proceed carefully. 
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NOTE: Be very careful when merging. The information will remain for the account that the name is 

being changed to, not the name that is being changed. For example, if an account has been created 

that is called B of A Checking and the account number from the bank has been entered on the edit 

account screen, then a new account just called Checking has been created without the account 

number. If B of A Checking is merged into Checking, the remaining account will not have the 

account number. If Checking is merged into B of A Checking, the account number will remain. The 

same is true for the other lists. For example, a customer with the address is merged into a customer 

without the address; the previous information will be lost! 

To merge two accounts, do the following: 

1. Click Lists>Chart of Accounts, highlight the account you want to merge, right click and 

choose Edit Account. 

2. If you are using account numbering, replace the account number with the account 

number for the account you want to retain. (If you are not using account numbering, you 

can type the exact spelling of the name (including spaces) of the destination account you 

are merging this one into.) 

3. QuickBooks cautions you that the name is already being used and asks whether you 

want to continue. 

4. Click Yes. 

 

Type the account number (or name of General Ledger account) you wish to keep. This will move 

the transactions from the old account, and ―merge‖ them into the account you want to keep. 
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Bank Service Charges will now be merged in Bank Fees account. 

 

Duplicate Items, Vendors, Customers, Other Names Lists can be merged following the same 

instructions. (Employee list items cannot be merged). 

NOTE: If the two accounts on the chart of accounts list to be merged are different account types, 

changing the name and the type cannot be done in one step. First change the account type and then 

change the name to merge the accounts together. 

NOTE: When Balance Sheet accounts are merged, any cleared transactions are merged into the new 

account as uncleared. 

OVERVIEW OF ITEMS 

Items handle the behind-the-scenes accounting in QuickBooks. When you create an item, you 

link it to a GL account; when the item is used in a transaction, it posts an entry to that account 

and another entry to the appropriate accounts receivable, accounts payable, checking, fixed 

asset, or other type of account. At Year-end you should review the Item list and the associated 

income and expense accounts each item is linked to help uncover many financial reporting errors. 

The most common error in the Item List is that the same item is linked on both purchase 

transactions and sales transactons and when the user set up the item they did not select the 

―This item is used in assemblies…..‖  Therefore, the appropriate expense and income accounts 

were not programmed when setting up the item. The following is an example of an item that was 

not assigned an expense account, only an income account. We call this a one-sided item, and it 

is this kind of setup that is usually the culprit when items post incorrectly on the GL.  
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If this item is used on either a Check or Bill and also on a customer Invoice, both the cost and the 

revenue will be recorded to the ―Labor Income‖ account as selected here. To correct this, see the 

following screen capture. Make the item a ―two-sided item‖. 

 

This setup will correctly record expenses to a cost of goods sold account on a purchase 

transaction and revenue to a revenue account on a sales transaction.  

CHANGING THE ACCOUNT(S) ASSIGNED TO AN ITEM 

It is possible to edit the accounts assigned to any of the item types (except Sales Tax types). 

When making a change to an account previously assigned to an item you will be given the choice 

to only affect transactions from this time forward or to go back and correct all previously recorded 

transactions. If you choose Yes, the financials will be restated. Before making these changes, 

make a backup of the client data and print the Trial Balance. That way, you can compare the 

results after you make the change and be sure it is what you wanted. 
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MISCLASSIFIED TRANSACTIONS 

Clients often are not consistent when the classify transactions and many are misclassified.  It can 

be cumbersome and time consuming to correct misclassifications.  But, in Client Data Review 

2010, we have a new Reclassify Transactions tool.  This will allow you to reclassify multiple 

transactions at the same time.  The ability to locate a vendor and evaluate the account that the 

purchases were posted from will save a lot of time during data cleanup. Below is the Client Data 

Review page. 

 

Notice the Reports:  Once you choose Reclassify Transactions, you will arrive at the main 

screen shown below.  Notice on this page there are links to the common reports we use when 

cleaning up a clients file.  This will allow you to reclassify the transactions and then go take a look 

at a fresh report:  

 

In the past, accounting professionals would analyze the Profit & Loss, Balance Sheet and 

review the account mappings from the Items List.  As we review the reports, we can often 

identify transactions which were entered incorrectly and posted to the wrong account.  Then, it 

was time consuming to correct each transaction or we would make reclassifying journal entries to 

correct the account balances.  But, then it was more difficult to see the detail transactions.  The 

new Reclassify Transaction tool will help streamline this process tremendously; however you 

cannot reclassify transactions with items using this tool.  If you identify Items which are mapped 

to the incorrect account, you need to make those corrections via the Items list. 

Consider these scenarios: 

 When examining the Profit & Loss Detail, we notice that the Office Supplies 

Expense account and includes several amounts paid to a vendor called Gina‘s 

Catering.  Upon further analysis, we determined that these should have been posted 

to Meals & Entertainment Expense account instead.  Previously, we would have to 
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edit each transaction individually to post it to the proper account or make a 

reclassifying journal entry to adjust the balances. 

 Perhaps a client is using classes, but there are numerous transaction with no class 

assigned.  Or a client wants to start using classes and needs to assign a class to 

existing transactions. Previously, we had to edit and correct each transaction which 

was either very time consuming or not feasible without using a third party application. 

The Reclassify Transaction tool in Client Data Review will save us lots of time by allowing us to 

identify and correct multiple transactions with one click! 

1. Select a name—either a vendor, customer or job.  

 The default date range is the review period, but you can change the date range 

if desired.  

 The default is to show transactions that you can reclassify.  Optionally, you 

could select to show All Transactions or Transactions you cannot reclassify—

item based.  

NOTE:  For your convenience, you can display item-based transactions, even though you 

cannot reclassify them with this tool, by changing the selection in the Show transactions 

dropdown list.  You should review the Items List to identify and correct items. 

 To include journal entries in the list, check the Include Journal Entries box.  

NOTE: You can QuickZoom on any transaction by double clicking it to see the entire 

transaction 
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2. Select one or more transactions to move to an account.  

For example, there are several transactions posted to Office Supplies which we want to reclassify 

to Meals & Entertainment. 

3. Select the new account and optionally a class in the list at the bottom of the 

window.  

4. Click on the Reclassify button. 

5. If there are more transactions for this name to reclassify, repeat steps 2-4 as many 

times as needed.  

For example, you may want to assign all these transactions to the Overhead class.  With this tool, 

you could click Select All, then select the Overhead Class and click Reclassify to quickly and 

efficiently assign all transactions to the proper class. 

NOTE:  Instead of selecting individual transactions, you can simply chose Select All, the 

proper Account and Class and Reclassify to fix all transactions quickly and efficiently. 
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After a few clicks, you‘ve corrected all these transactions to the proper account and class as 

shown below. 
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NOTE:  The Reclassify Transaction tool allows you to reclassify transactions to income or 

expense accounts (including cost of goods sold, other income or other expense).  But you 

cannot reclassify transactions to a balance sheet account.  You can reclassify a 

transaction that was posted to a balance sheet account to an income or expense account 

though. 

To illustrate:  If you identify transactions which were posted to Office Supplies Expense 

but they should have been a fixed asset, you cannot use the Reclassify Transaction tool to 

correct these.  

However, if you identify transactions which were posted to Fixed Assets but should have 

been posted to Office Supplies Expense, then the Reclassify Transaction tool can fix them 

for you. 
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GROWING BALANCE IN UNDEPOSITED FUNDS 

ERRORS & SYMPTOMS 

Common Errors: 

 User Makes Deposit without selecting payments from Undeposited Funds and typically 

posts it to an income account  

 Deposits were entered directly into the checkbook register—typically posting it to an 

income account 

Symptoms:  

 Accounts Receivable is high and A/R aging shows many old invoices  

 Growing balance in Undeposited Funds 

 Income is unreasonably high 

 Bank account balance looks correct and may have been reconciled 

Many of us have clients with a growing balance in Undeposited Funds. A common way this 

occurs is when the client Receives Payments and enter things correctly there. Then, they look in 

the check register and do not see the deposit (since it went into Undeposited funds when they 

Received Payments). So, now the client typically will enter the deposit and post it to an income 

account. The customer account balances are not misstated and the bank account balance is 

correct and can be reconciled. Often, then client is unaware that there is a problem. However, 

Undeposited Funds will be overstated along with income being overstated. 

The quickest and easiest way to look for Accounts Receivable errors is to review the A/R Aging 

Summary report. This report shows, at a glance, who owes the business money. It can be 

collapsed to show the amounts due by customer, or expanded to show the amounts due by job.  

Excessive amounts in the >90 days column is an indication something is wrong: It is either a 

QuickBooks data entry procedural issue, which is what we will address here, or it could be 

indicative of a bigger problem with management or concern issues which we will not be 

addressing in this publication. 
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Also, by looking at the Open Invoices Report you can identify if there are unapplied credits and 

payments. You can create this report by selecting Reports>Customers & Receivables>Open 

Invoices. You will see an invoice amount, then a payment or credit netting to zero. However, 

since these were not applied correctly, they are still considered open. 

 

PURPOSE OF THE UNDEPOSITED FUNDS ACCOUNT 
The Undeposited Funds account is part of the suggested workflow for Accounts Receivable. 

Typically there are four common steps to processing Accounts Receivable transactions: 

1. Create an invoice, sales receipt, or statement charge. 

2. Receive customer payments. 

3. Optionally, place payments into the Undeposited Funds account (preference settings will 

automate this). 

4. Complete the Make Deposits form, grouping the multiple customer payments onto a 

single Make Deposits form in QuickBooks, which then matches the deposit amount on 

the bank statement. 

The Undeposited Funds account is needed to hold payments received but not yet deposited. 

When you or your clients receive checks from customers, you may put them in the safe and then 

later add them up and take them to the bank; the Undeposited Funds account serves a similar 

purpose to the safe. It is a holding place for the checks and it should zero out after deposits have 

been made at the bank. 
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UNDEPOSITED FUNDS ACCOUNT REVIEW  

Before you can begin analyzing the Undeposited Funds account balance, it is best to review the 

QuickBooks data file first, concentrating on certain reports that will help to simplify the review 

process.  

Creating an Undeposited Funds Detail Report  

The first report to create to help with the analysis is a custom report called Undeposited Funds 

Detail. This is not a ready-made report in QuickBooks but it is easy to create and is highly useful, 

both for you, and for your clients.  

This report is fundamental because you cannot troubleshoot a total balance for the Undeposited 

Funds you see on a balance sheet report without also knowing the detail behind the numbers. If 

you print the register for the account you will see too much detail, making it hard to identify 

exactly what is not deposited. This report filters on just the right information.  

How do transactions get to this account? When you select the Undeposited Funds account as the 

deposit-to account (or you set the preference to have QuickBooks automatically do this), 

QuickBooks will increase the balance in the Undeposited Funds account whenever a customer 

payment is received and apply it to the outstanding invoice. Then, when a Make Deposit form is 

completed, QuickBooks reduces the Undeposited Funds account balance and behind the scenes 

marks both the original increase and the new decrease as cleared (as indicated by a check mark 

in the Undeposited Funds account register). QuickBooks later places the cash into the Bank 

Account specified on the Make Deposits form. That step is performed after the customer payment 

has been entered as received. 

To create the Undeposited Funds Detail custom report, follow these easy steps:  

1. Select Reports>Custom Transaction Detail. The Modify Report dialog automatically 

opens.  

2. Display the date range as All. (Tip: Simply type an ―a‖ without the quote marks to make 

the date range default to All.)  

3. For Total by select Payment Method from the bottom of the list.  

4. For Columns, select those that you want to view on the report. You can leave the default 

columns checked and add or delete them by clicking the modify button later. 

5. Click the Filters tab. On the filter pane select Account, and choose the Undeposited 

Funds Account from the drop-down menu.  

6. Also from the Filters tab select Cleared and click the No button.  

7. Optionally click the Header/Footer tab. Change the report title to Undeposited Funds 

Detail.  

8. Once the report is opened, you can memorize the report for future use.  
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NOTE: The modified custom report you named Undeposited Funds Detail will always show the 

present state of the transaction, which means that when a payment is received and is included on a 

Make Deposits form, the report for a prior date will no longer show that item as Undeposited. Behind 

the scenes, QuickBooks is marking the transaction as ‗cleared‘ as of the transaction date; therefore, 

you cannot get a historical snapshot.  

You can review this report to see if there are undeposited transactions that have been recorded 

improperly somewhere else, such as directly into the bank account register. And as stated earlier, 

this review is more accurate if the bank account has been reconciled prior to researching the 

undeposited funds balance.  
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UNDEPOSITED FUNDS ACCOUNT FIXES  

Did your review of the data uncover old dated payment transactions still in the Undeposited 

Funds account? Are there numerous transactions to be corrected or a not too many? There are 

two different methods to fix this error as illustrated by the following case study. 

Deposit Data Entry Case Study  

Q – My accountant just informed me that I have been doing my deposits all wrong. I had been 

entering an invoice to send to the customer then receiving the payment to show the invoice was 

paid. I looked in the check register and did not see the money, so I entered a deposit which 

agrees to the bank statement. Now I have a big mess because the income has been recorded 

twice (once from the invoice and once from the deposit). What can I do now to fix the problem? 

A – There are two alternatives, depending on the volume of transactions.  

One is to "reconcile" the deposits as of specific dates; the other is to fix the detail. 

The solution that will provide a clean trail of what has actually happened would be to "pull" the 

received payments onto the deposit slips. This can be done by using the new Clear up 

Undeposited Funds tool available in Client Data Review (or manually). 

The disadvantage is that this process can be more time consuming if there are numerous errors 

and you do not use the tool in CDR. However, if the deposit total does not change, it will not 

affect any of the bank reconciliation work already completed. That is the reason for changing the 

deposit as opposed to deleting it. (This is the first method discussed—Clear up Undeposited 

Funds with CDR). 

The fastest solution is to make a deposit each month by checking off all the Receive Payments 

for the month. Then say OK to "pull" these transactions onto the deposit slip, and then enter one 

line as a negative amount coded to the general ledger account where the previous deposits have 

been recorded. This will, in effect, reclassify the undeposited funds amount against the incorrectly 

recorded income. (This is the second method discussed—Fix Numerous Errors in Undeposited 

Funds without CDR). 

NOTE: If the Receive Payment option had not been used (i.e., the invoices were entered and the 

deposits entered directly onto a deposit slip or into the register) and there was only one payment per 

deposit slip, the most efficient correction may be to change the general ledger account code to 

Accounts Receivable. This method would require the customer: job in the name column. If multiple 

payments were deposited together, one of the options above would be needed. A second step of 

"linking" the invoice to the credit/payment would be required through the Receive Payments form. 
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CLEAR UP UNDEPOSITED FUNDS ACCOUNT WITH CDR 

Many of us have clients with a growing balance in Undeposited Funds. This usually occurs when 

the client Receives Payments and enters things correctly there. Then, they look in the check 

register and do not see the deposit (since it went into Undeposited funds when they Received 

Payments). So, now the client typically will enter the deposit and post it to an income account. 

The customer account balances are not misstated and the bank account balance is correct and 

can be reconciled. Often, the client is unaware that there is a problem. However, Undeposited 

Funds will be overstated along with income being overstated. 

In Client Data Review, there is a Clear up Undeposited Funds tool to help find and fix these 

errors. This tool is used to correct errors for Payments that are entered into QuickBooks but never 

carried through to a Deposit. Therefore, there is a payment entered into the file, as well as a 

manual deposit entered into the bank register by the client. This window allows you to match up 

the customer payments with the deposit entered in QuickBooks in order to clear the Undeposited 

Funds account.  

Below is the deposit entered by the client instead of selecting the payment from Undeposited 

Funds. The client typically entered the Deposit and posted it to the Construction Income:Labor 

account. 
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Using the Clear up Undeposited Funds tool within the Client Data Review, you can apply the 

payment to the deposit.  
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NOTE: When applying a Customer Payment to a Deposit in this window, the program replaces the 

manual coding of this entry entered by the client with the Undeposited Funds payment you are 

replacing it with (as illustrated in the screen shot below—the account is changed from the 

Construction Income:Labor account to the Undeposited Funds account. This corrects the underlying 

accounting error and eliminates revenue from being recognized twice. Additionally, the deposit 

amount remains unchanged so that the deposit remains reconciled, if applicable.  

 

NOTE: If payments are unapplied from multiple customers and were deposited as one deposit, Client 

Data Review will NOT resolve it. You will need to fix those deposits outside of Client Data Review. 

Client Data Review will only clear payments and deposits that are from the same customer. 
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FIXING NUMEROUS ERRORS IN UNDEPOSITED FUNDS WITHOUT CDR 

This method will allow you to remove the unwanted balance in the Undeposited Funds account 

without editing or modifying each transaction:  

If the funds that remain in the Undeposited Funds account are more than one year old, you first 

must identify the total amount that was incorrectly deposited for each year.  

Now ―remove‖ these identified Undeposited Funds items by clicking Banking>Make Deposits. 

The Payments to Deposit dialog appears. Do not sort the transactions; instead, leave the View 

Payment Method Type as All Types. QuickBooks will then list all payment types sorted by date 

within each payment type (see screen shot below).  

1. Select all the payments for deposit with dates in the date range you are correcting by 

clicking to place a check mark next to the payment item, as shown in the figure below, 

and then click OK. 
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2. The Make Deposits dialog opens with each of the previously selected payments included 

on the new Make Deposits form. On the next available line enter the account to which the 

incorrect deposits were originally recorded. In this example, you discovered that the 

Construction Income account was overstated by the incorrect deposits. The effect of this 

new transaction is to decrease (debit) Construction Income account and decrease (credit) 

the Undeposited Funds account without any affect on the checking account as shown in 

the picture below. 
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This method corrects the overstated account(s) (presumably income) and reduces Undeposited 

Funds. (You are in effect making a ‗zero‘ deposit that first clears out Undeposited Funds, and 

then debits the income account associated with the duplicate deposit entries made directly to the 

bank register.) One important Caveat….Before you do this, you will first want to be certain that all 

the payments you are removing from Undeposited Funds were in fact also posted to the Income 

account(s)t you are posting the debit to in the above example. Otherwise, you run the risk of 

understating revenue. 

To avoid this error in the future, make sure the transactions follow the proper procedures 

mentioned in the first part of this section. 

Additionally, if users are taught to utilize the daily tasks from the QuickBooks Home page, it will 

reduce the chance that mistakes are made by not following the proper procedures  

See the detail in section titled, ―Deposit Data Entry Case Study‖ for a detailed discussion on the 

options for fixing these types of mistakes.  

NOTE: A task that should be completed before you troubleshoot the undeposited funds detail is to 

reconcile the bank account. It will help with the review process if you can identify what transactions 

have cleared the bank and which customer payment transactions have been recorded in QuickBooks 

but did not clear the bank in a timely manner. 
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Setting Preferences to Avoid Future Errors  

For several years QuickBooks users have been given the choice as to whether to use the 

Undeposited Funds account for all accounts receivable payment transactions. In version 2008 

when a new data file is created, the preference to automatically use the Undeposited Funds (as 

shown below) account for customer payments is set at the Company level. You must be logged 

into the data file as the Admin or External Accountant user to view the Company Preferences tab 

for any preference tab.  

 

In 2010, this preference was moved to the Payments Preferences as shown below: 
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If you do not have the preference shown above selected, users should still use the Undeposited 

Funds account on a customer‘s receive payment transaction as shown in the below.  
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Without the preference set, QuickBooks will allow a user to post a payment directly to the bank 

account register. Adjusting the Preference at the Company level will ensure the customer 

payments always go to Undeposited Funds 

One of the most useful tools that you have to help clients in the proper use of QuickBooks is to 

review the many preference settings that set important defaults. Since many defaults are user 

specific, log in with the user name and then set the preferred defaults. 
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ACCOUNTS RECEIVABLE – SMALL OPEN BALANCES 
OR OPEN CREDITS 

ERRORS & SYMPTOMS 

Common Errors:  

 Payment not applied to an invoice 

 Credit issued and not applied to an invoice 

 Small balances need to be written off 

Symptoms: 

 Open invoices report is lengthy with unapplied credits, payments, and/or small account 

balances 

Before you begin to clean up open payments or credits or write off small balances, you should 

review the Open Invoices Report. You can create this report by selecting Reports, Customers & 

Receivables, Open Invoices. The date defaults to Today as shown in the image below. Looking at 

the data with Today‘s date is best, so that you do not attempt to write-off an amount that was 

applied on a later date to another open customer invoice 

As you review the report you may notice payments or credits that were not applied to an invoice. 

This leaves the invoice and payment or credit open although the customer balance may be zero 

resulting in a lengthy Open Invoices report. 
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FIX UNAPPLIED CUSTOMER PAYMENTS AND CREDITS WITH CDR 

Within the Client Data Review feature is the Fix Unapplied Customer Payments and credits tool. 

On one screen you are able to match Open Invoices with Customer Payments that have been 

received, but not applied to an invoice. To apply these transactions, select a name from the 

Customers tab, then on the Invoices & Charges tab, select a payment that you would like to 

apply to an invoice by checking it off. You can choose Auto Apply All to apply the payments or 

you can control which ones get applied to each other by performing the previous task, then 

choosing Apply.  

 

Once applied, transactions will be grayed on this window. If you want to start over or want to 

apply differently, you have the option to check off the transactions again and choose Unapply or 

choose Unapply All. When complete, choose Save & Close. 

NOTE: In 2009, the Client Data Review only pulled PAYMENTS and CREDITS that were not 

applied to an invoice. It did NOT pull DEPOSITS that were entered bypassing the Receive Payment 

process to match to an invoice. Also, it did NOT pull JOURNAL ENTRIES to a customer account 

either. You will need to find and fix these outside of Client Data Review as explained in the next 

section. 
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MANUALLY CLEANING UP OPEN ITEMS WITHOUT CDR 

Perhaps you need to clean up open items without the assistance of the tool in CDR. Also, if a 

Journal Entry was entered to Accounts Receivable, it will not be reflected in the CDR tool 

discussed above. In the event that a deposit was entered to Accounts Receivable (not an income 

account), this would not be reflected in the CDR tool either. In the event that you need to 

manually apply open items to invoices, use the following procedures. 

1. Go into Receive Payments, select the appropriate customer, leave the amount as zero 

and click on Discounts & Credits. 
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2. Within the Discounts and Credits, select the credit or Journal Entry to apply to an open 

invoice.  
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WRITE-OFF SMALL BALANCES 

In the newer versions of QuickBooks it is much easier to write off small open amounts when 

customers shorted or over paid the invoice by small, insignificant amounts. One method to easily 

write-off these small balances begins in the Receive Payments dialog. To get to the Receive 

Payment form, first bring up the Open Invoices report then simply double click on the invoice 

with the open balance. Click on the History link at the top of the invoice to open the Transaction 

History dialog box.  

 

From the Transaction History dialog, click the Go To button (see above) to open the Customer 

Payments dialog shown below. Select the radial button for Write off the extra amount. 
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Select Save & Close to open the Write Off Amount dialog (see below) where you can then select 

the GL account you have chosen to hold this amount. Typically the account is an Expense 

account type but may also be a Current Asset type if an accrual is made for anticipated bad 

debts. 

 

Write off Invoices Tool in Client Data Review 

Using the new Write Off Invoices tool, you can write off invoices, statement charges, or financial 

charges from a single window—in batch.  This tool will save you time and allow you to quickly 

clean up accounts receivable.  . 
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NOTE:  You should use the Fix Unapplied Customer Payments and Credits Tool prior to 

Write Off Invoices.  If there are Credits available, you will see this warning message. 

 

This tool allows you to specify and write off a group of invoices to the write-off account you 

specify. There is no limit to the number of invoices you can write off at once. There are four parts 

to writing off invoices. 

1. Create a list of invoices by entering criteria and then clicking Find All.  

Fill in any of the criteria on the screen to limit the list, and then click Find All. If you do not choose 

any criteria, all open invoices appear on the list. 

The criteria selected will vary based on the client‘s industry, the size of the client and a number of 

factors.  It is advised that you use your professional judgment and discussions with your client to 

determine which invoices should be written off.  

The following criteria can be used: 

 Dates – There are four date options:  

o >120 days – invoice date is prior to today by 120 days or more  

o >180 days – invoice date is prior to today by 180 days or more  

o Review Period – invoice date is within the review period  

o Custom – invoice date is prior to the date you set in the Up to field  

Note: The Up to field is set automatically to 120 days before today, 180 days before today, 

or to the last day of the review period, depending on your selection, unless you choose 

Custom. Then, you must enter the date in the Up to field, either by typing it in or by using 

calendar icon at the right of the field.  

 Balance Due less than – The maximum invoice amount to display on the list  

 A/R Account – The Accounts Receivable account associated with an invoice to 

display on the list.  This will only appear if there is more than one accounts 

receivable type of account set up in the chart of accounts 

 Transaction Type – The type of transaction that an invoice must contain to 

display on the list. Valid types are Invoices, Finance Charges, Statement 

Charges, and All 3 
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Note: You can click on the column headings in the table of invoices at any time to sort the 

list by that column. If you have selected criteria to limit the list of invoices that displays, 

the limited list is sorted by clicking a column heading. For example, you can set the 

criteria to display invoices more than 180 days old, but then sort that list by customer 

name. 

 

NOTE:  If a customer has credit, it would be good idea to apply it before writing off 

invoices.  As shown in the above screen shot, the column “Avail Credit/Pmt” would 

display a blue link “CREDIT” for those customers with available credits.  When you click 

this link, the Fix Unapplied Payments and Credits window opens where you can apply 

credits to the open invoices.   

2. Select the invoices to write off.  

 Click a checkbox next to an invoice to select it.  

 Click Select All to select all the invoices in the list.  

 Click Deselect All to clear all the checkboxes. After deselecting all the invoices, 

you must select again.  

3. Specify the write-off terms.  

 Select the Write Off Account from the list. A write off account is required.  
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 Change the write off date, if necessary. A write-off date is required. By default it 

is the last day of the reviewing period. 

 Enter a write off class. A write-off class is optional and can help track types of 

write offs 

 

 

4. Review and write off selected invoices.  

Click Review and Write Off Selected Invoices. A confirmation of the write off appears which 

shows all the invoices to write off, the write-off account, and the total amount to write off. Click 

Write Off to complete the write off, or click Cancel to return to the main window. 

 

Note: If you cancel the write off, the invoices are still selected. Click Deselect All to clear the 

selection, or continue working with the selected list. Some examples when keeping the selection 

is useful are when you want to change the write-off account, and when you want to remove an 

invoice from the list.  
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 Internally, each invoice that you write off is discounted. A memo is added to the invoice and the 

discount transaction. All invoices that you write off with this feature are tracked. To see the list 

anytime during the review, select Audit Trail of Review from the CDR center.  

For the invoices written off, a Discount will be entered and noted in the accounts receivable 

register as shown in the screen shot below. 
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ACCOUNTS PAYABLE ERRORS 

ERRORS & SYMPTOMS 

Common errors: 

 Client enters bills and then writes checks  

 There are unapplied vendor credits 

Symptoms:  

 Accounts Payable balance is very high with numerous old A/P 

 Expenses seem unreasonably high 

 The bank account balance appears correct 

 Numerous unapplied vendor credits 

The quickest and easiest way to look for this Accounts Payable error is to review the A/P Aging 

Summary report. The Accounts Payable Aging Summary provides a quick snapshot of the 

outstanding bills as of a specific date. Most of the amounts should be relatively current. An 

extremely old amount may indicate an error or a situation that requires an adjustment. 

Consistently old amounts due can indicate a profitability or cash flow situation that should be 

addressed immediately. Any vendor that have a zero balance in total indicate that all transactions 

have not been ―linked.‖ (Credits have not been applied to the bills in question.) 

Excessive amounts in the >90 days column is an indication something is wrong: It is either a 

QuickBooks data entry procedural issue, which is what we will address here, or it could be 

indicative of a bigger problem with management or concern issues which we will not be 

addressing.  
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FIX UNAPPLIED VENDOR PAYMENTS AND CREDITS  

In Client Data Review, there is a Fix Unapplied Vendor Payments and Credits tool to help find 

and fix these errors This feature works the same as applying Unapplied Customer Payments to 

Invoices. Except in this case, checks are shown that are written to Vendors that are not Bill 

Payments. Therefore, there are Bills outstanding even though checks were written to the vendor 

or outstanding vendor credits are available but were never applied. Checks and Vendor Credits 

are applied in the same fashion as described in the Accounts Receivable section of this 

document.  

  

NOTE: In 2009, the Client Data Review only pulls vendor credits and checks that were posted to 

Accounts Payable. It did NOT pull CHECKS that were written to the vendor and posted to the 

expense account. The following section explains how to correct these errors. 



Most Common QuickBooks Mistakes and How to Fix Them 

53 

CHECK WAS WRITTEN INSTEAD OF PAY BILLS 

In older versions of QuickBooks, it was common to find that the client Entered Bills but then used 

the Write Checks function instead of Pay Bills. Typically, the client would record the check to the 

expense account resulting in expenses being doubled. Accounts Payable would also be 

overstated with numerous old, unpaid bills in Accounts Payable which had in fact been paid.  

Although there is improved messaging (see image below) in newer versions of QuickBooks, you 

still may encounter this mistake. In order to fix the error, you need to consider whether the client 

is on the cash or accrual basis of accounting and whether the bank account has been reconciled 

or not.  

 

ACCRUAL BASIS – NO BANK RECONCILIATION 
If the client is on the accrual basis of accounting and the bank reconciliation has not been 

completed, the incorrectly entered checks can be simply deleted and you can re-enter them using 

the Pay Bills function. One of the beauties of QuickBooks is that you can delete transactions and 

re-enter them correctly. Don‘t forget to back up the data file and print the check register or have 

the check copies in hand prior to pressing the delete button. There is no ―undo‖ or ―undelete‖ 

available so be careful when using this alternative. Once you delete the checks you must then go 

in and Pay Bills to record the payment to the vendor. Having the check register printed up before 

you delete the checks will help you assign the correct check numbers and dates to the new bill 

payments. 
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ACCRUAL BASIS – BANK RECONCILIATION COMPLETED 

For accrual basis reports, the bill and bill payment dates are critical. If the payment to the vendor 

has already been entered as a check and the bank reconciliation has been completed, deleting 

the check as described above will change the beginning bank balance and with extensive delete 

and re-enter procedures, the likelihood of an error increases. For this reason, the 

recommendation is to change the account code on the check to Accounts Payable. This will 

create a credit on the Accounts Payable reports, which can then be linked to the bill. The main 

trick to know when completing the correction in this way is that the vendor name will be required 

on the check detail line that contains the account of Accounts Payable. 

Step 1 – Correct Coding of Check 

In the Vendor Center, locate the check that was entered incorrectly and edit the check changing 

the account to Accounts Payable and including the vendor name in the Customer:Job field as 

illustrated below. 
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Record the change. Complete this same procedure for all checks that should be linked to a bill. 

Step 2 – Link Check to Bill 

Next, go into Pay Bills and select the appropriate Bill to pay and click on Set Credits as shown 

below. 
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Within the Discounts & Credits screen, you should select the appropriate credit (i.e., the check 

that was just edited) to be applied to the Bill. (Note the check number is in the reference field). 

 

Then, you will see the credit applied to the bill with the actual Amount to Pay being zero since you 

are merely linking the two transactions together.  
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Continue this process for all the bills and checks that need to be linked. When the process is 

complete for all the transactions, click on the Pay & Close button.  

A warning may appear that can be acknowledged that states in the older versions that no check 

will be generated. The message in the newest version is: 
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CASH BASIS – BILLS NOT NEEDED 

If the client is on the cash basis and accrual reports will not be needed for management, historical 

or any other purpose, it is possible to delete the bills. Do not delete bills if job costing is used on 

the bill level unless you are prepared to duplicate the job costing on the check itself.  

The easiest way to delete the bills is to go to the Accounts Payable register and delete them. By 

doing it in this way, it is easy to make sure the bill has, in fact, not been completely or partially 

paid. If there has been a complete or partial payment linked to the bill a warning message will 

appear (see below) and you should no delete the bill (correct it using the method described in the 

previous section). 

 

Once this process is complete, create the Reports, Vendors & Payables, Unpaid Bills Detail 

report to confirm that everything look correct. Note that the checks themselves are still listed in 

the Check Register – you may wish to review the expense account coding on the check to ensure 

accuracy on the P&L. 
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CREDIT CARD ERRORS 

ERRORS & SYMPTOMS 

Common errors: 

 Only the amount to be paid is entered into QuickBooks with some type of ‗guesstimate‘ of 

how the payment should be allocated 

 Accounts Payable was used to enter bills for revolving debt balances 

 Balance is a single entry in expense account 

 Credit card balances were not reconciled in QuickBooks at all 

Symptoms:   

 Accounts payable balance seems high with numerous credit card bills  

 Expenses seem unreasonably high 

 Credit card register balance only increases 

 The bank account balance looks appears correct 

First, there is the confusion of the term credit card: are you accepting credit cards as a form of 

payment from customers or clients or are you using a credit card to pay someone else? Then 

there is the discussion on how the information should be entered into QuickBooks properly.  

If the business carries a credit card revolving balance (i.e., the credit card is not paid in full every 

month), even occasionally, then the easiest method of tracking the amount due is using a credit 

card type account. 

If the business uses a credit card but pays the balance in full each month like any other vendor, 

using the Accounts Payable feature to enter a bill each month when the statement arrives is 

probably acceptable. The transactions can be split on the expense and item tab of the bill to 

reflect accurately in the general ledger. The only potential problem with this method is any timing 

differences based on the date of the bill versus the date of the transactions. It is important to 

accrue the charges into the proper period at year end—including cash basis clients. 

A common error is that only the amount to be paid is entered into QuickBooks with some type of 

―guesstimate‖ of how the payment should be allocated. Or to eliminate guessing and the time 

consuming process of actually entering the detail of the charges incurred on the credit card one 

expense account is used for all credit card charges. Both of these errors create significant 

distortion of the financial statements due to missing or misclassified expenditures. 
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USING BUSINESS CREDIT CARDS OVERVIEW 

Revolving debt is a way of life for many small businesses. This additional leverage permits growth 

that would not otherwise be possible. Keeping track of the balances and related charges can be a 

challenge.  

NOTE: The credit card feature in QuickBooks can be used to track other revolving debt as well as 

credit cards. For example, a Line of Credit with a bank or Due to Owner (when the owner paid for 

business expenses personally but the business cannot repay the owner yet) could be entered and 

tracked using the credit card feature. 

 

CREDIT CARD TYPE ACCOUNT 

Although QuickBooks has Accounts Payable features that could be used, separating the feature 

specifically designed for entering and reconciling credit card charges from paying for goods and 

services is much more efficient. The reasons include: 

 A reconciliation process that includes balancing QuickBooks to the statement from the 

credit card company and automatically generating a check or bill to pay all or a portion of 

amount due. 

 Accounts Payable Aging Reports and due dates are distorted when the entire balance is 

not paid in full. 

 Credit card charges are typically deductible for income tax purposes whether the credit 

card company has been paid or not. When creating reports on the cash basis, Accounts 

Payable transactions coded to Profit and Loss accounts will automatically reverse. 
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CREDIT CARD TRANSACTION ENTRY - ONE ENTRY OR MANY? 

The first step in using the credit card feature is to enter the charges and credits as the credit card 

is used to pay for the purchase of goods and services. 

Entering the individual charges as the credit card is used (or downloading them via Online 

Banking) will eliminate the need to do it when the statement comes each month, plus recording 

the transactions throughout the month will result in more accurate interim financial information. In 

many situations, for a variety of reasons, this is not practical for some businesses.  

There are other alternatives including: 

 Enter one charge for the month for the total amount purchased using the credit card and 

manually reconcile the receipts to the statement. The detail lines can be entered as splits 

so the general ledger remains accurate; or 

 Enter one charge for the month for the total amount purchased and code it to a credit 

card clearing account that will be reclassified based on the receipts at a later time. This 

method can be more cumbersome; or 

 Enter the detail transactions individually when the statement arrives and any transactions 

without a receipt are noted as such in the memo field (so a report can be generated and 

cleared as receipts are obtained) or coded to a credit card clearing account pending 

reconciliation with the receipts. 

The most important issue with any of these methods is that the procedures are documented and 

followed exactly each time. This will eliminate reconciliation nightmares in the future. It is also 

important as documentation when receipts are difficult to obtain.  



Most Common QuickBooks Mistakes and How to Fix Them 

62 

CREDIT CARD RECONCILIATION 

When the statement arrives, it should be reconciled. This process is very similar to the bank 

account reconciliation process. 

 

The main difference between reconciling a checking account and reconciling a credit card 

account is that at the end of the reconciliation process when the ―Reconcile Now‖ button has 

been clicked, a screen will appear to provide an alternative to enter a check to pay the credit card 

now or a bill to pay the credit card later (see image below). Either choice is acceptable. The most 

important decision to make is the amount that will be paid. By default the amount to be paid is the 

full account balance. The amount should be overridden based on what the actual payment will be 

to permit reconciliation with the next statement. If this amount changes prior to the check printing 

process, the bill or check should be changed to reflect the actual payment. 



Most Common QuickBooks Mistakes and How to Fix Them 

63 

 

EXTRA PAYMENTS 
Making extra payments is an excellent way for businesses to reduce expensive revolving credit 

card debt. With the ease of online payments for most cards, and the fact that even a few days of 

less interest can result in notable savings, many business have begun using this as a method to 

reduce expenses. 

For example, an outstanding balance of $10,000 at 15.99% interest is $133.25/month. Making the 

minimum payment (typically 2%) of $200 barely covers the interest charge. The small amount 

that goes to reduce the debt will only result in about $1 reduction in the next month‘s interest 

charge. However, making the minimum on the due date, and paying an additional payment will 

make a significant difference in reducing the principal balance of the debt and therefore reducing 

the interest charges that continue to accrue. 

Since a check or bill for the additional payment will not be created as part of the reconciliation 

process, it will be necessary to manually enter it. The trick to entering the transaction correctly is 

to code the payment on the expense tab to the credit card type (liability GL) account. This will 

reduce the credit card liability and record the payment for the next reconciliation. 
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SALES TAX ERRORS 

ERRORS & SYMPTOMS 

Common errors: 

 Clients Write Checks (or check register) to pay sales tax liabilities 

 Sales taxes not set up properly 

Symptoms:   

 There is a balance in sales tax payable and sales tax expense 

 The Pay Sales Tax dialog does not show previous payments 

 Sales taxes not calculating properly 

There are several steps involved to ensure that sales taxes are set up and used properly. Clients 

often make mistakes somewhere in the set up and use of sales taxes.  

Sales Tax type Items in QuickBooks record the default tax rate to charge your customers and 

record the taxing authority to which the sales tax collection is remitted.  

Sales Tax Codes track the taxable status of the products and/or services that are sold and the 

taxable status of the customer. Sales tax codes can also be used to get reporting breakdowns on 

multiple types of non-taxable sales.  

Sales Tax Groups are optional in QuickBooks. In many states you are required to report the 

collection of sales tax for a combination of city, county, and state but you only have to show the 

customer one tax rate. In QuickBooks this can be accomplish by first creating the individual city, 

county, and state sales tax items, and then assigning them to a Sales Tax Group item type. The 

Sales Tax Group item is then assigned to the customer.  
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REPORTS TO REVIEW PROPER SALES TAX LIABILITY BALANCES 

This section‘s title can be a bit misleading because the reports we are referring to are reports that 

we recommend be reviewed each time you get ready to pay sales and use tax to the taxing 

authority. Properly ―reconciling‖ these reports to each other helps minimize any chance that the 

QuickBooks data will not support what was filed on the sales tax return.  

Reviewing Customer Lists for Tax Code and Tax Item Assigned  

It is recommended that you check the customer‘s taxable status on a regular basis. This task is 

quite easy to do often and helps prevent the costly mistakes caused by not charging sales tax or 

by charging the incorrect rate.  

1. Click Reports>Lists and select the Customer Phone List report.  

2. Click the Modify Report button on the top left of the report.  

3. In the Display dialog that opens, in the Columns pane, click to place a check mark next 

to items you want to review for the list, including Sales Tax Code and Tax Item, and 

include the Resale Num if you track this number for your wholesale customers.  

4. Optionally, select Sort By at the top right, and from the drop-down list select Sales Tax 

Code.  

5. Optionally, click the Header/Footer tab to change the report title.  

6. From this list (shown in the figure below) you can conveniently double-click any line item 

detail to open the Edit Customer dialog and make any needed changes.  

7. Memorize this report for regular use. 

 

Prepare this report often to review the sales tax codes and items assigned to customers and to 

verify the accuracy of the setup. 
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NOTE: When you make a change to a customer‘s assigned tax code or tax item or to the tax code 

assigned to a product or service that is sold on the item list, QuickBooks will not correct or modify 

prior saved transactions. Only new transactions will show the change in the sales tax status or rate.  

Reviewing Item List for Tax Code Assigned  

Another review that is recommended to be done periodically is to look at the list of services and 

products that are sold and determine whether the proper tax code has been assigned (see image 

below). 

1. Click Reports> Lists and select the Item Price List report, which you will modify.  

2. Click the Modify Report button at the top left of the report.  

3. In the Display dialog that appears, remove check marks from those data fields you do 

not want displayed on this report. Place a check mark next to date fields you want to 

review for the list, including Sales Tax Code.  

4. Optionally, select Sort By at the top right, and from the drop-down list select Sales Tax 

Code.  

5. Optionally, click the Header/Footer tab to change the report title.  

 

Prepare a report of the items and the sales tax codes assigned to them to verify the accuracy of 

your setup.  
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Reconciling Total Sales on Sales Tax Payable to Total Income  
on Profit & Loss  

The term reconciling refers to the need to compare two related numbers from two different 

reports. The importance of this task cannot be overstated. If the company is selected to have a 

sales tax audit, one of the first numbers the auditor will want to determine is the total sales that 

were reported on the tax returns for the time period being audited.  

To compare total sales on the Sales Tax Liability report to total income on the Profit & Loss 

Report:  

1. Click Reports>Vendors & Payables and select the Sales Tax Liability report.  

2. Make a note of the total sales on this report.  

3. Click Reports>Company & Financial, and select the Profit & Loss Standard report.  

4. Compare total income to the total sales from the Sales Tax Liability report. Note: You 

might have to deduct any non-sales income on the Profit & Loss Total Income amounts.  

5. Compare total sales on the Sales Tax Liability report to total income on the Profit & Loss 

report.  

When Total Sales Does Not Match Total Income  

What can cause total sales on the Sales Tax Liability report to not match total income on the 

Profit & Loss report? Some of the reasons might be the following:  

 Different accounting basis between reports―The Sales Tax Liability report basis is in 

conflict with the Profit & Loss reporting basis. The basis of the report is by default printed 

on the top left of the report. Both reports must be either Accrual Basis or both must be 

Cash Basis before comparing. (See the section, ―Preferences That Affect Sales Tax.‖)  

 Non-sales transactions recorded to income accounts (i.e., other than Invoices, Sales 

Receipts or Statement Charges)—one method to locate these transactions is to double-

click the total income amount on the Profit & Loss report. Doing so opens the Transaction 

Detail by Account report. At the top right of the report, select Sort By and choose Type. 

Within each income account group, QuickBooks will sort the transactions by transaction 

type. Review the report for non-sales transaction types such as General Journal or Bill (to 

name a couple). If you find a Bill on this report, it can be due to improperly setting up the 

items. To determine how to fix this type of error see Chapter 3, the section titled 

―Correcting One-Sided Items.‖  

 Income recorded as a result of vendor discounts—If an income account was set up for 

vendor discounts in the bills preferences setting, you will need to deduct this amount from 

the total revenue when you compare the two totals. Create a separate income account 

for these discounts so that you can easily identify them.  

Additionally, QuickBooks will default the Sales Tax Liability report dates based on the preference 

setting as Accrual Basis (sales tax due based on date of invoice) or Cash Basis (Sales Tax Due 

based on date of customer payment).  
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Reconciling Sales Tax Liability to Balance Sheet Sales Tax Payable  

Another equally important comparison to make is between the balance on the Balance Sheet 

Sales Tax Payable amount and the amount showing payable on the Sales Tax Liability report.  

If you (or the client) created your own Sales Tax Payable account, you might not be able to 

correctly compare the two reports. QuickBooks creates the Sales Tax Payable account 

automatically.  

To compare the Balance Sheet Sales Tax Payable with the Sales Tax Liability report:  

1. Click Reports>Company & Financial and choose Balance Sheet.  

2. On the report, select the As of Date you are comparing to; this date must be the same 

ending date you will prepare the Sales Tax Liability report in the next step.  

3. Click Reports>Vendors & Payables and choose the Sales Tax Liability report. 

QuickBooks will default the date range depending on the sales tax preference setting.  

4. Balance Sheet Sales Tax payable should agree with the Sales Tax Liability report.  

Each month before preparing the sales tax return, compare the total of these two reports. If they 

do not agree, read the sections in this handbook on Sales Tax Fixes.  

 

Look for transactions such as a General Journal entries (as shown above) that will affect the 

sales totals but will not be in included in total sales on the Sales Tax Payable report. If your client 

wrote a check and coded it to the Sales Tax Liability account, the Sales Tax Liability has not been 

relieved, so Sales Tax will still show as due on the Sales Tax reports. The following sections 

details how to make the necessary corrections. 
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CORRECTING SALES TAX PAYMENT ERRORS  

Sales tax errors can be a bit tricky to fix, so make sure you have asked yourself the following 

questions:  

 Have you made a backup of the data file? 

 Have taxes or financials been prepared using the data in its current state? If yes, then 

you need to be concerned about the dates and types of the corrections you make.  

 If the QuickBooks sales tax due is incorrect, have you determined outside QuickBooks 

how much was or is due?  

Print the sales tax reports before you begin to make corrections to the data file. Then make a 

backup of the company data file. Then, when your corrections are complete print the same 

reports to be sure you achieved the desired end result. And, of course, keep good paper 

documentation of why you did what you did in case there is a sales tax audit.  

FIND AND/OR FIX INCORRECTLY PAID SALES TAX  

Within the Client Data Review is a new tool to Find Incorrectly Paid Sales Tax in 2009 and to Fix 

Incorrectly Paid Sales Tax in 2010. When selecting this option in 2009 Client Data Review, a 

report generates (shown below) that gives you all Check or Journal Entry transactions in 

QuickBooks coded to a Sales Tax vendor in QuickBooks. This helps isolate entries that were 

made outside of the Sales Tax Payment module in QuickBooks so a correction can be made. 

 

In 2010 Client Data Review, the tool Finds and Fixes Incorrectly Paid Sales taxes by voiding and 

replacing the check.  Plus, it maintains the cleared status of the check. 
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When a Check was used to pay the Sales Tax 

In newer versions of QuickBooks the error of using a check to pay sales tax should happen less 

often. QuickBooks provides messages to users attempting to pay their sales tax vendors 

incorrectly.  

If a user tries to pay a vendor that is associated with a sales tax item, or to use the Sales Tax 

Payable account in the Write Checks window, QuickBooks provides the warnings shown below. 
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NOTE: However, if someone clicks the ‗Do not display this message in the future‘, then the warning 

will not display. You can bring back this message (and others), by editing the General preferences as 

shown below. 

 

If you find there was a payment made by check, first determine whether the check has been 

included in the bank reconciliation; if it hasn‘t, simply void the check and re-create using the 

Vendors, Sales Tax, Pay Sales Tax option (using the same check number, date, and amount). 
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If the check has already been included in the bank reconciliation, use this method to properly 

assign the sales tax payment check or bill to the line items in the Pay Sales Tax dialog: 

1. Select the check from the steps listed in the previous section. Double-click the check to 

open the Write Checks dialog. 

2. If not already assigned, assign the Sales Tax Payable liability account in the Account 

column of the Expenses tab. 

3. In the Customer:Job column, select the Sales Tax Vendor from the list of vendors 

(make sure it is a vendor and not an ‗other name‘ list item). 

4. Click Save & Close to close the check form 

5. Select Vendors>Sales Tax, and choose the Pay Sales Tax option. 

6. Place a check mark next to each sales tax line item, including the line item with the 

correction to associate the check form with the sales tax due. (See the figure below). If 

the net total amount is zero, you do not need to concern yourself with the other fields in 

the window. 

 

QuickBooks now enables you to assign the corrected check to the sales tax payable without 

issuing a new check. 

The net entry is zero, so no check will be issued. However, QuickBooks will now associate the 

check with the related sales tax due and when you return to the Pay Sales Tax dialog, the 

amount previously showing as unpaid will no longer be there. If the net entry was not zero, you 

might need to record a sales tax adjustment. 
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ADJUST SALES TAX PAYABLE  

The Sales Tax Adjustment window appears when selecting this line item. Any Sales Tax 

adjustments that need to be made should be made through this window rather than using a 

Journal Entry. 
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PAYROLL ERRORS 

ERRORS & SYMPTOMS 

Common errors: 

 Clients Write Checks (or check register) to pay payroll tax liabilities 

Symptoms:   

 Payroll Liabilities are higher than expected 

 Payroll Tax Expense is higher than expected 

 Bank account balance appears correct 

 Payroll tax returns have been prepared and filed showing no balance due (and no notices 

to the contrary have been received) 

Payroll, (and inventory discussed elsewhere), are the two areas where QuickBooks is less 

forgiving and clients are more likely to make mistakes.  

Most often the errors are the result of incorrect or inconsistent procedures.  

The most common error in this area is that the ―Pay Payroll Liabilities‖ feature was not used; 

rather payroll tax payments were entered using Write Checks or Enter Bill functions. 

WARNINGS REDUCE ERRORS  

Users of recent versions of QuickBooks are less likely to make any errors setting up or managing 

payroll from pay period to pay period.  

This is due in great part to the new Payroll Setup Tool. If this menu choice is not available, you 

first need to subscribe to one of Intuit‘s payroll offerings. There is a service that is just right for 

each company‘s payroll needs.  

QuickBooks payroll works best when all payroll activity is perfromed from within the payroll 

menus. This includes paying accrued payroll taxes to the respective taxing authorities. If the 

company has written checks or vendor bills paying for these liabilities, and the QuickBooks-

created Payroll Liabilities account was assigned, the following warning message appears: 
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This warning helps prevent users from using the wrong type of payment (i.e., Write Checks or 

Enter Bills) when attempting to make payroll liability payments. When the user clicks the Pay 

Payroll Liabilities button in the warning message, the user is directed to the Select Date Range 

for Liabilities dialog. The message directs the user to use the Pay Payroll Liabilities feature to 

create a payroll liability check.  
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FIND INCORRECTLY PAID PAYROLL LIABILITIES  

When selecting this line item with Client Data Review, a similar report as in the Sales Tax section 

is generated. A report generates that gives you all manual Check transactions in QuickBooks 

coded to a Payroll Tax vendor in QuickBooks as shown in the image below. This helps isolate 

entries that were made outside of the Payroll Liability Payment module in QuickBooks so an 

adjustment can be made. 

 

Correcting Payroll Liability Payment Errors  

There are two methods for correcting these. First, if you have identified non-payroll forms (i.e., a 

check or bill) paying for the payroll liabilities, you can properly fix them after determining that the 

check or bill payment check has not cleared the bank and has not been included in the monthly 

bank reconciliation. Void the existing check or bill that is paying the payroll liabilities and recreate 

it correctly by clicking Employees>Payroll Taxes & Liabilities and selecting Pay Scheduled 

Liabilities.  

The second method should be used if the check (or bill payment check form) that improperly paid 

your payroll liabilities has been cleared in the bank reconciliation. You will not want to void the 

check or bill payment check as it would negatively affect the recorded bank reconciliation. Rather 

than using a Journal Entry to make the correction, you should use the Payroll Liability Adjustment 

to make the correction. 

In recent versions of QuickBooks users will rarely make the mistake of not properly paying your 

payroll liabilities. However, to have QuickBooks automatically warn users when improperly paying 

these payroll liabilities, the payroll liabilities account must be the account that QuickBooks created 

automatically. Using any other user-created payroll liabilities account will not provide the user 

warning. 

Beginning with QuickBooks 2008, the warning will direct users to the proper menu for paying 

payroll liabilities. 
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GETTING THE RED OUT—CLEARING OUT PAST DUE LIABILITIES 

The client may have overdue amounts showing in the Pay Scheduled Liabilities as red when in 

fact they are current and there is nothing past due. This occurs when they enter a regular check 

and code it to the proper accounts, but they did not go through the ‗Pay Liabilities‘ window. First, 

you should verify that the amounts have been paid and make a note of the check number. The 

following steps will ‗Get the Red Out‘. 

Select the appropriate item from the Pay Scheduled Liabilities window as shown below and 

click the View/Pay button. 
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In the Liability Payment Check window, change the check amount to zero and add additional lines 

in the expenses area for the same accounts already listed with a negative amount to offset the 

entry. Include the actual check number used to pay the liabilities in the memo section as a 

reference. The result will be offsetting amounts so there is no impact on the accounts, but it will 

clear it from the Pay Liabilities window.  
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ADDITIONAL AREAS TO TROUBLESHOOT PAYROLL ERRORS 

Importance of Payroll Item Account Mapping 

Payroll items, when originally created, must be assigned a General Ledger account for the 

Liability or Expense derived from the payroll transactions. To locate errors in this setup select the 

Reports menu, Lists, then the Payroll Items Listing report. This report shows the payroll 

earnings, deductions, and tax items. It also shows the current tax table limits and rates. A quick 

review of this report will identify if the wrong General Ledger account was set up. Double-click on 

any item to make changes. Any changes made will affect prior period transactions.  

 

Reconciling Payroll Transactions in the Bank Reconciliation Process 

QuickBooks can produce all of the federal and state tax forms (quarterly and annual) for filing 

depending on which Intuit payroll subscription is purchased. Prior to preparing these forms, the 

bank reconciliation should be performed.  

Identifying uncleared payroll checks before the forms are processed can save time in restating 

payroll report transaction totals. Often, uncleared payroll checks are issued in error and affect 

Payroll reports used to prepare the federal and state forms. 
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LOCATING NON-PAYROLL TRANSACTIONS 

Finding these transactions before filing a return can save time amending or correcting payroll 

returns later on. 

From the Employees menu, choose Employee Center, then the Transactions tab. From this 

area, you can sort payroll transactions by transaction type and by date range to identify any 

entries recorded in error.  

For example below, there is a non-payroll check issued to Gregg. This might be OK, but might 

also be an error. It is worth investigating with the business owner to see if this was an incorrectly-

entered paycheck. 

 

CREATING PAYROLL LIABILITY CHECKS DIRECTLY  
IN THE CHECKBOOK REGISTER 

To properly process payroll liability checks, select the Employees menu, Employee Center. 

Click on the Payroll tab, then View/Pay Scheduled Liabilities. From there you can create the 

Payroll Liability check. Often, checks are directly created from the checkbook register. This 

results in Payroll Liabilities in the Payroll Module being overstated as compared with the balance 

on the Balance Sheet. 

Users can correct these by creating the original transaction again at Employee Center>Payroll 

Tab>View/Pay Scheduled Liabilities, then voiding or deleting the original check that was 

created in error. If the bank account has been reconciled another method is to create a liability 

adjustment by selecting Employees>Employee Center. Click on the Payroll tab and choose 

Related Payment Activities>Adjust Payroll Liabilities. Users can select to affect General 

Ledger accounts or not depending on how the check register checks were written. 
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NOTE: You would choose Do not affect accounts if the General Ledger is correct overall and all you 

want to do is get the liability adjusted out of the payroll module and reports. This situation would 

arise if the client paid the right payroll liability amounts on time, and used the correct General Ledger 

coding on the checks written to the taxing authorities, but just did not write the checks correctly using 

the ―Pay Scheduled Liabilities‖ area of QuickBooks. 

In the example shown below, we are choosing to affect the Liability and Expense Accounts. 
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INVENTORY ERRORS 

ERRORS & SYMPTOMS 

Common Error: 

 Incorrect and/or inconsistent inventory procedures 

Symptoms: 

 Inventory Valuation Summary report does not appear correct 

 Inventory quantity is negative or too high 

 Average cost appears too high, too low or is zero 

 Asset value does not agree with the General Ledger 

Inventory, along with payroll, is consistently one of the most problematic areas for clients who are 

doing the bookkeeping themselves. While the process seems straight forward, incorrect and/or 

inconsistent procedures create errors that can be more challenging to correct. 

The first issue, before any work is done on the file, should be to determine if inventory type parts 

are appropriate for the client or if their needs would be better served with non-inventory parts 

where the perpetual count and average cost is not an issue. 

Assuming inventory is appropriate for the client, the quickest way to get an overview of the extent 

of the situation is to compare the inventory valuation summary report to the Balance Sheet 

inventory asset balance as of the same date. The detail on the report itself - negative inventory 

balances or average cost amounts that do not look reasonable - provide some key indicators, a 

difference between the Asset Value total on the report and the inventory asset balance in the 

general ledger is another tell tale sign that some work will be needed in this area. 

As part of the reconciliation and cleanup process, it may be necessary to deal with additional 

issues such as correct procedures, what is the unit of measure, and how use tax, samples, etc. 

are being recorded. 

In 2010, Client Data Review provides us with some new tools to troubleshoot Inventory—the 

Compare Balance Sheet and Inventory Valuation and Troubleshoot Inventory window.  

CDR Tool—Compare Balance Sheet and Inventory Valuation 

QuickBooks enables average costing for the inventory value. The total asset value on this report 

should agree on the same date with the Balance Sheet value for Inventory. If you create Journal 

Entries and post them directly to the Inventory account, the Inventory Valuation Summary will not 

agree to the Inventory Asset balance on your Balance Sheet. Additionally, inventory items with 

Quantity On Hand that have been made inactive will also cause a discrepancy between the 

inventory valuation summary report and the totals for the inventory asset account on the financial 

statements or trial balance. To correct, re-activate the inventory item to make the proper physical 

inventory adjustment (as discussed below), then inactivate once again so the inventory valuation 

summary report will tie to the financials. 

The new Compare Balance Sheet and Inventory Valuation tool determines whether the 

inventory account on the Balance Sheet and the Inventory Valuation Summary match. The tool 

checks the inventory account and Inventory Valuation Summary when it is opened and displays 

the results. 
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A green circle indicates that the inventory account on the Balance Sheet and the Inventory 

Valuation Summary match. 

A yellow warning triangle indicates that there is a discrepancy between the inventory account on 

the Balance Sheet and the Inventory Valuation Summary. Two major causes of discrepancies are 

non-inventory accounts affecting inventory transactions and incorrect setup of the accounts for 

inventory items. 

The default date for the comparison is the last day of the review period. You can change the date 

in the As of field and click Refresh to help you narrow down the date when the discrepancy 

occurred. 

 

If the tool shows a discrepancy, the following links are available to help you fix the problem. 

 Links to the Balance Sheet and Inventory Valuation Summary as of the selected date. 

You can change the As of date, refresh, and click these links again to see the Balance 

Sheet and Inventory Valuation Summary as of the new date.  

 A link to a report that shows Transactions using an inventory asset account but not 

inventory items.  This report lists all transactions (such as a Journal Entry, Check or Bill) 

that were posted to the Inventory Asset account without an inventory item.  If it were a 

check or bill, you could edit the transaction to include the item and not the inventory 

account on the expenses tab.  If it were a journal entry, then it would be necessary to 

delete or void the Journal Entry and enter an Inventory adjustment for the appropriate 

item for the adjustment. 
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 A link to Add/Edit Multiple List Entries window to review the inventory setup.  

 A link to the Adjust Inventory Quantity/Value on Hand   

 A link to the Item List.  

After following any of these links, you can close them and remain in the Compare Balance sheet 

and Inventory Valuation tool. 

CDR Tool—Troubleshoot Inventory 

Many clients who track inventory make mistakes when recording purchase or sale of inventory 

items.  Having a negative quantity is a problem, and can affect how QuickBooks calculates 

average cost.  It might take a lot of time to identify a specific transaction that caused negative 

inventory. 

The New Troubleshoot Inventory tool will help you to find possible errors.  You can see if the 

negative value occurred as of the end of the period…or any time during the review period; see if 

there are inactive items that have a quantity on hand, or items with a percent of markup that is 

less than an amount you specify…  All in one window. 

 

 Note the layout of this window: The item list is show in spreadsheet format.  There are 

filter options displayed on the top left. You have column customization on the top right 

and a link to the inventory adjustment window on the bottom. 

 Filter Options: There are many filter options to choose from.  You can filter for all items or 

only active items by clicking the Show Items filter drop down box. You can also check 

mark specific criteria like ―Negative Quantity‖ and ―Inactive items with Qty on Hand‖ 
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 Editing an item: Each item name is displayed as a clickable link.  Double clicking the 

item name link will take you to the Edit Item window. You will be prompted to go to 

Add/Edit List Entries window with a Yes/No option. 

 Marking items as inactive: You can mark an item or multiple items as inactive directly 

from this window.  Check mark which items you wish to mark as inactive and then 

click Make Selected Items Inactive. 

 Negative Inventory: Negative Inventory is indicated by a yellow warning sign and a 

Yes/No message in the far right column.  Double click on the amount showing as 

negative and the Inventory Valuation report appears. Note: this tool does not have the 

ability to automatically fix negative inventory as the fix can vary from client to client.  

However, an accountant can adjust inventory by clicking the Adjust Quantity/Value on 

Hand link on the bottom of the window.  You can also set the negative inventory alerts to 

display by the as of date or any time in date range by selecting your desired option in 

the bottom right corner of the window. 

 Customizing Columns: Click on the Columns to Display link.  Note: by default 

QuickBooks marks all available columns that way customers know what is available and 

can remove what they want from this window.  To remove a column, simply click on the 

check mark next to the column name and click save. 
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INVENTORY FIXES 

Items Overview 

An item is anything that a business will sell. The easiest way to think about an item is to 

understand that it is the link between the information entered into a form (invoice, check, etc.) and 

the transaction that is recorded to the various accounts in the general ledger. Any line that will 

have a corresponding dollar amount with it will require an item. The list can be as simple or as 

complicated as you choose. For example, if the business sells pizzas, one item is all that is 

required. As each invoice is created, the description and price could be revised as needed. The 

other alternative would be to create items for each of the different kinds of pizzas sold. This 

approach would eliminate the need for revisions as the invoice is created since the description 

and price would come up automatically. More sophisticated sales reports would also be possible 

in the latter example. 

There are many judgment calls and different ways to achieve accurate general ledger results. 

Review of the item list is critical to:  

 Confirm that the items have been set up correctly and  

 Confirm that the decisions made are appropriate for the business based on the flow of 

paperwork, accounting knowledge, QuickBooks experience, etc. 
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Item Types 

When creating an item list, there are several choices of item type to choose from. The type is 

important for subtotals on reports and for some function options. 

Below is a list of the types and the typical use for each: 

 Service - most commonly used for items such as labor, consulting, hourly fees, etc. This 

type of item is required for use on timesheets. 

 Inventory part - items that are normally carried in stock until sold. This item type will keep 

a running balance of quantity on hand and moving average cost. This item type will 

record purchases into an Other Current Asset account when purchased and reclassify 

the appropriate amount to cost of goods sold when an invoice or cash sale receipt is 

created. Detailed discussion of this type of item is beyond the scope of these materials. 

 Inventory assembly - items that are created from other inventory items (i.e., assembled) 

then carried in stock until sold. This is a new item type with version 2003 and above, 

Premier only. This item type will keep a running balance of quantity on hand and moving 

average cost. This item type will record purchases into an Other Current Asset account 

when purchased and reclassify the appropriate amount to cost of goods sold when an 

invoice or cash sale receipt is created. Detailed discussion of this type of item is beyond 

the scope of these materials. 

 Non-inventory part - items that are not kept in stock. This could include items such as 

custom or special orders. This item type is also used if the average cost method of 

valuing inventory is unacceptable or perpetual inventory counts are not necessary. As 

items are purchased, they are simply expensed. 

 Other charge - freight, gift-wrapping services or other expenses that are passed through 

to the customer are all examples of other charge type items. If an ―opening bal‖ item is to 

be created for entering the beginning balances for a new set up for Accounts Receivable 

and Accounts Payable, this is usually the type that is used. 

 Subtotal - a special item type that permits a subtotal line on an invoice to accumulate the 

amount due of all lines entered previously. 

 Group - this item type is used when several items are sold at the same time. There is the 

flexibility of printing all of the individual components on the customer‘s copy of the 

invoice, or showing the detail only on the screen with one line on the printed copy of the 

invoice that merges the detail together. The primary drawback to this item is, although 

inventory and any other items are correctly reflected as a group is sold, there is not a way 

to run reports on the group itself. For example, if an installed door set is sold that includes 

a door, the hardware, and labor, a sales report will show the appropriate amount of 

revenue for each component but will not show how much revenue was generated from 

the sale of the door set group, only how many doors were sold, installed or not. 

 Discount - this is a reduction on the invoice that can be either a flat dollar amount or a 

percentage of the line immediately preceding it. If a discount is to be given off of each 

item, the discount will be entered either after each item, or once after a subtotal of all 

items.  
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 Payment - if a payment is received at the time of the invoice, this is the item type to be 

used. Keep in mind, however, that a statement shows only the totals from transactions, 

i.e., the invoice on the statement will show the net amount due on the statement after the 

sale and payment have both been entered. If it is important to show the payment on the 

statement, entering an invoice then creating a receive payment transaction may be 

preferred. 

 Sales Tax - based on the customer being taxable, and the item being taxable, this item 

will calculate the tax liability due based on the tax percentage entered. 

 Sales Tax Group - in California, it is the recommendation of this author that the sales tax 

for each county be each created as a unique sales tax item, rather than entering the 

individual jurisdictions and grouping them together. The resulting sales tax liability report 

will be easier to reconcile using this method. 

Inventory Versus Non-inventory Type Parts 

Inventory in QuickBooks is based on average cost. If this is an acceptable method for the 

business, QuickBooks works well when set up correctly and proper procedures are followed 

consistently for buying, selling and adjusting the inventory item balances. With that being said, 

when are inventory type items appropriate and when are non-inventory type items a better 

alternative? 

Let us start with the definition of inventory parts versus non-inventory parts.  

With inventory, the same item is coded to an asset, a cost of goods sold, and an income type 

account. As the items are purchased (on the items tab of a bill, check, credit card charge, etc) the 

inventory balance is increased for the quantity and cost of the item on the balance sheet. When 

the item is sold, the average cost is deducted from the inventory asset account and recorded in 

cost of goods sold.  

Non-inventory parts, however, only have one account and both the purchases and sales are 

recorded to the one account. To modify this, it is possible to edit the item and check the box in the 

middle of the item (Pro and higher only) to use the advanced job costing features (as shown in 

the image below). What the box says on the item is not important, what is important is that by 

checking the box the item now has "two sides:" One account for purchases and one for sales. 

With non-inventory type parts, the purchase is expensed and the sale is recorded as income. 

There is no matching of the timing between the two. 
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Items can be changed for coding corrections, or to change a non-inventory part to inventory. 

There is not any way to change the items from inventory to non-inventory (short of starting a new 

file or making the inventory items inactive). Make any changes carefully, because it is possible 

that depending on what you choose all the history could change as well (affecting prior year 

balances).  

The most important aspect of using inventory is to always buy it before it is sold. Make sure that 

clients do not ignore warning messages that state that there is not enough in inventory to sell. 

This message is indicative of the way they are using inventory in QuickBooks. Don‘t sell into 

negative inventory. 
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Inventory Purchases vs Sales 

By virtue of being a perpetual inventory system proper procedures are critical. One of these is 

using the same item for purchases (i.e., bills, checks, item receipts) as well as for sales (i.e., 

invoices, cash sales receipts). The quickest way to confirm the item is used when buying the 

product as well as when the product is sold is to do a quick report. 
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Item Receipts 

If an item has been received, but the bill has not arrived, create an item receipt. An item receipt 

will not age in Accounts Payable until the form is edited to confirm that the bill has been received 

(i.e., it does not show on the pay bills window). The item receipt will increase the Inventory and 

Accounts Payable balances. This information can be linked to a purchase order either when the 

vendor name is entered, or from the Select PO button at the bottom of the items tab.  

 

If no Purchase Order exists, simply enter the information manually on the item tab of the form. 

NOTE: When the bill is received, click on the box in the upper right hand corner and the terms and 

due date fields will appear. This will activate proper aging and permit bill payment procedures. This 

step is important, if a new bill is entered rather than the item receipt being edited, the Inventory and 

Accounts Payable balances will be inflated. You can also achieve these same steps by entering a bill 

for items already received from the home page. 
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Inventory Quantity or Value Adjustments 

To review the value of the Inventory Subledger select the Reports menu, then Inventory, choose 

Inventory Valuation Summary. This report provides information about the quantity on hand as 

well as the value it is assigned in Inventory. 

 

QuickBooks enables average costing for the inventory value. The total asset value on this report 

should agree on the same date with the Balance Sheet value for Inventory. If users create 

Journal Entries and post them directly to the Inventory account, the Inventory Valuation Summary 

will not agree to the Inventory Asset balance on the Balance Sheet.  

Create the following report to identify any transactions that are posted to the Inventory account 

and that are resulting from Journal Entries. Reports>Custom Transaction Detail>Modify 

Report to all dates>Advanced (button lower right) >select In Use>Filter for Inventory Account 

then create the report. At the top right of the report select sort by Type and then review the report 

for non-inventory transaction types (like a General Journal). 
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The correct process is to make a change to Inventory for quantity changes or value changes from 

Vendors>Inventory Activities>adjust Quantity/Value on Hand. 

 

By selecting the box Value Adjustment, you can change the value of the inventory as well as the 

quantity. This transaction will correctly modify the total Inventory Valuation Summary and the 

Balance Sheet Balance for the Inventory Asset account. 
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PRIOR PERIOD BALANCES DISCREPANCIES 

ERRORS & SYMPTOMS 

Common Error: 

 Users record, modify, delete and void transactions in accounting periods that have 

already had taxes prepared from the data.  

Symptoms: 

 Ending balances used by the tax accountant have changed from year to year. 

One of the most frustrating things for accountants using any software is when they begin the work 

for the new period and the prior period balances have changed. 

The great news here is QuickBooks provides some really great tools for not only preventing 

changes to prior periods, but also finding them if they in fact do get made. An especially great 

new tool is in Client Data Review—the Troubleshoot Account Balances tool. 

TROUBLESHOOT ACCOUNT BALANCES  

The first year that you use Client Data Review in QuickBooks, you will need to enter in the Ending 

Trial Balance from the prior period‘s tax return or financial statement. When you start Client Data 

Review in future periods, this will automatically be populated by QuickBooks in the Last Review 

Balances column. After entering in the Trial Balance from the previous period, the Difference 

column calculates the entry that needs to be made to adjust QuickBooks back to the last 

reviewed balance. You can review the transactions that contributed to the balance discrepancy by 

double clicking on the difference in blue and QuickZoom into the discrepancy. Alternatively, you 

can also select View Changed Transactions at the top of the window to get a report of the 

balances that contributed to the discrepancy. Once you have reviewed the differences and agree 

with proposed adjustment, select View Suggested Adjustments.  
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After selecting View Suggested Adjustments, QuickBooks opens the Make Journal Entries 

window. The Adjusting Entry box is checked with the journal entry date being the ending date of 

the prior period. Note that in this example, part of the adjustment is to Accounts Receivable. 

Therefore, you need to enter a customer in this line of the journal entry similar to ―ADJ Customer‖. 

Once you have reviewed the adjustment and made any necessary changes, select Save & 

Close. 
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Once you select to save the Adjusting Journal Entry, the following message appears: 

 

Choose to View Suggested Reversing Entries if you would like any part of the entry to reverse 

at 1/1. If there are certain accounts you want to remove or add to the reversing journal entry, you 

have the flexibility to do so once the journal entry appears. Then choose Save & Close on the 

reversing entry. If you prefer not to reverse the entry at 1/1, then choose Don’t Reverse. 

As you complete each task, you can change the status from Not Started to In Progress or 

Completed. 

ADDITIONAL REPORTING TO HELP TROUBLESHOOT BEGINNING 

BALANCE CHANGES IN QUICKBOOKS 
QuickBooks provides several reports to assist in troubleshooting beginning balances when you 

cannot identify the problem through the Client Data Review tool. Each of these reports can be 

found by selecting Reports, Accountant & Taxes and choosing a report that will best troubleshoot 

the problem in the beginning balance discrepancy. 

Audit Trail Report 

The Audit Trail Report lists all transactions entered into the file and the complete history of 

changes, deletions and /or voids to those transactions. If a client makes a change to a prior 

period transaction, the Audit Trail Report will show the effects of the change.  
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Like other QuickBooks reports, it is possible to filter the Audit Trail Report on a number of 

different criteria. To do this, select Export from the report window and select the Advanced tab of 

the Export Report window. Then check the box labeled Auto Filtering as shown below. With 

Auto Filtering turned on, you can then filter each column to only show transactions that match the 

criteria you choose. 

 

NOTE: The Audit Trail will only show ―who‖ did what, provided that your client has set up a unique 

User ID for each person entering transactions into QuickBooks. If every person is sharing the same 

User ID (which is not recommended!) the Audit Trail will simply show a list of the transactions and 

changes to the file, but not ―who‖ did those entries. 



Most Common QuickBooks Mistakes and How to Fix Them 

99 

Closing Date Exceptions Report 

This report shows modified or transactions entered dated on or before the Closing Date. Similar 

to the Audit Trail Report, the current status of the transaction as well as the original transaction 

are shown. You can view the transactions that might need to be reversed, or adjusted, to get 

back to the correct balances.  

NOTE: This report will only show data if a Closing Date has been established, and if entries or 

changes are then made to those closed period(s). Also – it only tracks changes made after the Closing 

Date has been established. If you make changes to an open period, then establish a Closing Date, the 

changes you made before establishing the Closing Date are not tracked. For this reason, it is best 

practice to close periods regularly and set a password for each period. However, the Audit Trail will 

record ALL transactions regardless of closed or open status for each period. 
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Voided/Deleted Transactions Report 

In QuickBooks versions 2005 or later, QuickBooks creates an activity log of all voided and 

deleted transactions. This report is not dependent on the Closing Date because QuickBooks 

tracks the activity whether or not the transaction is dated in a previous reporting period.  

 

To display more information about a transaction on this report, double-click on the transaction. 

QuickBooks will then display the impact of the original transaction on the General Ledger. 
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Retained Earnings Quick Report 

In QuickBooks 2005 and newer versions you can view the detail of transactions posted to 

Retained Earnings. Select the Lists menu>Chart of Accounts and then double click on 

Retained Earnings account. 

 

Identify entries made in error to the Retained Earnings Account. Double click on an entry to edit 

and correct the account assigned.  
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Open Working Trial Balance 

If you prefer to make all of your entries through the Working Trial Balance in the Client Data 

Review Tool as journal entries, then you can enter all of your adjustments through this screen. 

You will be able to: 

 See your client's net income at a glance after each adjusting entry 

 Review transactions in your client's accounts, including the Retained Earnings account. 

 Enter adjusting journal entries 

 Enter your workpaper references for account adjustments 

 

Edit transactions or make adjusting journal entries from this window. Select Make Adjustments to 

open the Make General Journal Entries window in the next screen capture. 
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QuickBooks defaults this entry as an ―Adjusting Entry‖ so that it will appear in the Adjustments 

column on the Working Trial Balance window. Selecting a time period on the Make General 

Journal Entries screen will allow you to see a list of all journal entries and if they are adjusting or 

not. 

SET CLOSING DATE AND PASSWORD  

It is very important to set a Closing Date and Password so that your changes are saved and 

cannot be undone unless the user knows the password. Even if the client knows your password 

and makes changes after you give the data file back, the Closing Date Exception Report records 

any changes they make, as long as this is set. When selecting this line item, the following window 

appears: 
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Select Set Date/Password in the Accounting section on the Company Preferences tab, then 

enter the Closing Date and Closing Date Password where prompted. 

 

You may want to use your phone number or name as the password to prompt the client to call 

you before making the entry. Some accounts use passwords such as $500 so they client knows 

how much it will cost to fix or file an amended tax return if they make a change to the prior year. 
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OPENING BALANCE EQUITY ACCOUNT  

ERRORS & SYMPTOMS 

Common Error: 

 Users do not know that they should close the Open Balance Equity account to Retained 

Earnings 

 Users enter an opening balance when setting up a new account, vendor, customer or 

inventory item 

 Users create transactions that post to the Open Balance Equity account  

Symptoms: 

 Balance remains in Open Balance Equity account long after start up of the data file 

 Open Balance Equity account balance is not zero 

WHY TRANSACTIONS POST TO THE OPEN BALANCE EQUITY ACCOUNT  
QuickBooks automatically records the following transactions to the Opening Balance Equity 

account:  

 The ending bank statement balance transaction when a new bank account is created in 

the EasyStep Interview  

 Opening balances for other Balance Sheet report accounts created in the Add New 

Account dialog  

 Opening balances entered when New Customers or Vendors are setup 

 Inventory total value balances entered in the New Item dialog  

 Bank reconciliation adjustments for QuickBooks versions 2005 or earlier 

Other common transactions that a user might assign to this account include: 

 Accrual basis opening accounts payable transactions as of the start date 

 Accrual basis opening accounts receivable transactions as of the start date 

 Uncleared bank checks or deposits (accrual or cash basis) as of the start date 
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REVIEWING BALANCES IN OPEN BALANCE EQUITY ACCOUNT 

Before you begin reviewing the data for transactions in the Opening Balance Equity account, 

verify that there is a balance in this account.  

To create a Balance Sheet Standard report:  

1. Click Reports>Company & Financial and select the Balance Sheet Standard report. 

2. Without adjusting the date, view the Equity section of the report to see whether a 

balance exists in the account. 

Technically, the Opening Balance Equity account value should be equal to the prior year 

Retained Earnings. So, if there is a balance in the Opening Balance Equity account and if the 

balance is equal to the prior year‘s Retained Earnings, you might simply be able to ‗close‘ 

Opening Balance Equity into Retained Earnings—as discussed in the next section. 

If, however, a balance appears on the Balance Sheet and you have completed the opening 

balances, including closing Opening Balance Equity into Retained Earnings, you can review the 

individual transactions by creating the following report: 

1. Click Reports>Custom Transaction Detail Report. The Modify Report dialog appears, 

with the Display tab selected.  

2. Select the Report Date Range you want to view. It is recommended that you choose All 

from the Dates drop-down menu.  

3. In the Columns section of the Display tab, click to place a check mark next to those data 

fields you want to see on the report, or click to remove the check mark from those you 

don‘t want to see on the report. Be sure to include Type near the top of the list.  

4. Click the Filters tab.  

5. In the Choose Filter pane, select Account; from the Account drop-down menu select the 

Opening Balance Equity account, as shown in the image below. 

6. Optionally, for the Sort By drop-down list, select Type. This option groups the report by 

type of transaction, which might make reviewing the source of the transactions easier. 
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With the report sorted by type of transaction, you can begin to determine whether errors in entries 

were made. 

One of the most important things to know about the Opening Balance Equity account is that when 

a file is completely and successfully set up, no balances should remain in the Opening Balance 

Equity account. 
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Closing Opening Balance Equity to Retained Earnings 

The Opening Balance Equity account should have a zero balance once a file is set up correctly. A 

correctly set up QuickBooks file assumes the following: 

 You are not converting the data from Quicken, Peachtree, Microsoft Small Business 

Accounting or Office Accounting. Each of these products has an automated conversion 

tool available free from Intuit that eliminates the need to do startup transactions if you 

convert the data and not just lists. 

 The company had transactions prior to the QuickBooks start date (i.e., it is not a new 

business). If it is a new business with no prior transactions, then you will simply begin 

entering typical QuickBooks transactions with no need for unusual start up entries. 

 If there were transactions prior to the QuickBooks start date, you have entered each of 

the unpaid customer invoices, unpaid vendor bills, and uncleared bank transactions and 

dated them prior to the QuickBooks start date. 

 You have entered and dated the trial balance one day before the QuickBooks start date. 

(i.e. if the fiscal year starts 1/1 then the trial balance is dated 12/31 of the previous year). 

 When you create a Trial Balance report in QuickBooks dated one day before the 

QuickBooks start date, it agrees with the accountant‘s trial balance or with the trial 

balance from the prior financial software with the exception that there is a balance in the 

Opening Balance Equity account. 

If you answered yes to each of these assumptions, then it is expected that the Opening Balance 

Equity is equal to the Retained Earnings balance from the accountant‘s financials or from the 

prior software. 

If it does not agree, then you need to continue to review the data to identify the errors. 

If it does agree, then you are prepared to make the final entry in the startup process to close out 

the balance in Opening Balance Equity to Retained Earnings. 
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MISCELLANEOUS HELPFUL INFORMATION 

WORKING WITH PAYPAL ACCOUNTS  
More clients are using PayPal for business transactions. To record these transactions in 

QuickBooks, create a new account and select the account type of ‗Bank‘ as shown in the image 

below. Now, users can record purchases paid for with the PayPal account as well as deposits into 

the PayPal account as with any other bank account in QuickBooks.  

 

When users record a deposit to the PayPal account, add another line to record the PayPal fees 

so the net deposit matches the PayPal amount. Users should also reconcile the QuickBooks 

PayPal account to PayPal reports. 
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Downloading and Importing PayPal Transactions 

Another option is to download transactions from PayPal and import them into QuickBooks.  

 As always, create a back up of the data file BEFORE you download and import 

transactions 

 Only import the download once, or there will be duplicate entries 

 If you want to test/try it in a sample file do this: 

o Create a backup of your QuickBooks file 

o Restore the backup giving it a name of practice (when it is saving the file) 

In the newly restored file, go to Company, company information, and change the name to 

‗practice‘ (so on the blue title bar you‘ll see that you‘re in your practice file). 

To download PayPal account activity: 

1. Log into your PayPal account. 

2. Go to the My Account tab. 

3. Right above the transactions, click on the all account activity link. 

4. On the left side, in the History box, click on Download My History link. 

5. Select the dates of transactions that you want to download (after your first download, it is 

a good idea to select last download to present so you do not duplicate transactions). 

6. Select the File type to download—QuickBooks (iif). 
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7. It will ask what accounts you want to use for the PayPal account, expense account (for 

the fees and any payments that were made), and income account (Donations—Online). 

 

8. Save the file to an appropriate folder on your hard drive—possibly name it with the date 

9. In QuickBooks, go to File>Utilities>Import>iif, and select the file you just saved 

10. It will automatically deduct the PayPal fees from deposits 

11. It will put the Payee‘s name on the other names list. You can move them to the customer 

list by doing this: 

a. Go to Lists>Other Names List, and double click on the appropriate name 

b. On the right (under OK, Cancel, etc.) you‘ll see a box for Change Type 

c. Change the type to customer  

12. When you transfer funds from PayPal into your bank account, you need to enter the 

transfer into QuickBooks. Go to Banking>Transfer>From the PayPal account, to the 

checking account for the appropriate amount. 

JOURNAL ENTRIES OVERVIEW 

In traditional accounting, the journal entry is a record of a transaction in which the total amount in 

the Debit column equals the total amount in the Credit column, and each amount is assigned to 

an account on the chart of accounts. For the day-to-day transaction entry, QuickBooks uses 

familiar forms (invoices, bills, checks, etc.) and the back-end journal entries are created 

automatically. When you enter a transaction directly into a non-bank balance sheet account 

register, QuickBooks automatically labels the transaction GENJRNL in the register and General 

Journal on reports that list transactions. 

In traditional accounting systems you must perform various closing procedures. QuickBooks 

automates this process by automatically transferring net income into the Retained Earning 

account at the beginning of a new fiscal year when Balance Sheet reports are created. You 

cannot view a journal entry to see this process, it occurs automatically.  
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If the net profit or loss each year should be ―closed‖ into an account other than Retained 

Earnings, there are two ways to handle this issue. One is to change the name of the account (i.e., 

for a sole proprietorship change the name of Retained Earnings to Owner‘s Equity). The second 

alternative is to create a journal entry to reclassify the amount correctly (i.e., reclassify retained 

earnings to various partner accounts). To protect the integrity of the data for the future, use the 

password protection feature of closing dates. 

On the company pull down menu you can choose to make manual journal entries. In traditional 

accounting systems, to ―post‖ is to transfer data from the book of original entry to a ledger. In 

QuickBooks, the original entry is on a form (invoice, bill, check, and so on), and the equivalent of 

a ledger is a report. QuickBooks handles all posting automatically and immediately when you 

record the form.  

QuickBooks also allows you to correct mistakes by editing and recording the original form again 

at any time. To protect previous records from accidental change, use a QuickBooks password 

and closing date. 

Entries for depreciation, tax provisions, etc. must be made in the more traditional fashion. For 

clients using job costing reports, there are several places which do not permit you to assign a 

customer to the amounts, so a journal entry is required to reclassify the amount within the same 

account from no name (i.e., blank) customer to the correct customer: job. 

With many traditional software packages, any adjustments are handled through journal entries in 

the general ledger. In QuickBooks, however, the creation of journal entries, and their impact on 

the financial statements, may not achieve the desired results, and are better handled through the 

use of the appropriate form or transaction entry page. 
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Each transaction is recorded in the general ledger via journal entries. It is possible to create a 

report that presents the details for each transaction. This report, by default, includes the feature of 

collapsing the detail lines for the same account into one line. This is indicated by the notation of 

―multiple‖ in the memo column. To see the individual detail lines, click on the expand button at the 

top of the report. This report can also be filtered for a specific transaction type (for example, 

journal), by date entered/modified, by a specific memo, etc. 
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Journal Entry Rules 

Typical journal entries for QuickBooks include booking depreciation entries, income tax 

provisions, and loan interest adjustments. If it has been determined that a journal entry is in fact 

needed, keep in mind the following rules: 

 Only one Accounts Receivable or Accounts Payable type account per entry. 

 On the journal entry itself, use the Accounts Receivable or Accounts Payable account on 

the second line of the journal entry so that it properly posts. 

 Any entry to an Accounts Receivable or Accounts Payable type account will require a 

customer or vendor, respectively. 

 If QuickBooks is used as a write up program and Accounts Receivable or Accounts 

Payable detail is provided from another system, it is usually more efficient to create the 

accounts using the other current asset or other current liability type accounts. 

 All journal entries may be considered to be cash basis, regardless of the accounts 

affected based on where the Accounts Receivable and Accounts Payable accounts are 

placed in the journal entry. 

 Journal entries should not be made to inventory or payroll accounts. To do so may create 

subsidiary reports that do not agree with the general ledger. 

 Entries can be made to correct class entries by choosing the same account for the debit 

and credit and only making the class designation different. This will re-allocate between 

classes, while leaving the GL account the same. 

 As each journal entry is saved, the general ledger is automatically updated. 
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 To create a report of just the journal entries, filter the Transaction Detail by Account 

report or the Audit Trail report for the transaction type of journal. If only the accountant 

journal entries are to be printed, choose the entered/modified date from the point that the 

financial statement reconciliation work began to the current date. 

RECORDING EXPENSES PAID FOR BY THE OWNER 
Frequently business owners will pay for business expenses with personal funds—even though we 

routinely advise them to keep business and personal funds separate! How to record these 

business expenses in QuickBooks depends on whether the business will repay the owner or not.  

 If the business account has funds available, users can write a check to reimburse the 

owner for the business expenditures paid for with personal funds.  

 If the owner does not want to reimburse themselves, a journal entry can be made to 

record the expenditures and owners contribution (equity account)—it may be necessary 

to consult with a tax professional if the business is a partnership or corporation. 

 In some cases, the owner may wish to be reimbursed, but the business does not have 

the funds available to make the payment now. In this situation, a journal entry could be 

posted to a Due to Owner liability account. If there is a lot of activity, you might consider 

using a credit card type of account for these transactions as discussed in the section on 

Credit Cards. 

CREATE A PRACTICE/TESTING FILE 
There are many times when using a practice or testing file is beneficial. Clients really appreciate 

being able to learn in a practice file with their own company data. You can create a practice file 

from an actual data file as follows: 

 Create a backup of the QuickBooks file 

 Restore the backup, saving the file under a different name (Practice, Sample, Testing) 

 In the newly restored practice file, go to Company>company information, and change 

the name to ‗practice‘ (so on the blue title bar you‘ll see that you‘re in your practice file). 

You may also want to change the color of the desktop so it is clear that it is the practice 

file. Go to Edit>Preferences>Desktop>My Preferences, and change the color scheme. 

Clients can switch between the practice and real file via File>Open Previous Company.  

 


